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INTRODUCTION

Welcome to the user manual for the Dualz MOSAIC Multiviewer Editor. This powerful tool is designed to facilitate
seamless user interface management for your mosaic network configuration. Operating locally or across any
LAN/WAN network, the editor connects effortlessly to mosaic servers, allowing users to configure and customize
their multiviewer setups with ease. The core of the editor’s functionality lies in the XML file, which serves as the
primary storage and reference document for all mosaic network configurations. This manual will guide you
through the features and capabilities of the editor, ensuring an efficient and user-friendly experience.

INSTALLATION

INSTALLATION PROCEDURE

This section outlines the steps for installing the Dualz MOSAIC Editor as part of the MOSAIC installation or as a
standalone application on a remote system.

1. Prerequisites
e  Ensure that your system meets the following requirements:
o Operating System: Any Windows OS, Win 11 preferred.

o GPU card: MOSAIC supports CPU decoding, but best performance is reached by using a good GPU
card. For a good performance indication, refer to our hw references on the Dualz website:
https://dualz.com/hw-reference-mosaic

2. Installing as Part of MOSAIC Installation
e [finstalling the MOSAIC Editor as part of a complete MOSAIC installation, follow these steps:

1. Download the MOSAIC installation package from the official website.

2. Run the installation executable.

3. Follow the on-screen instructions:
= Accept the license agreement.
= Choose the installation directory, preferred to keep the default.
= Select which pre-installed config you want, or none.

4. Complete the installation and launch the MOSAIC Editor from the start menu or desktop
shortcut. The screen can be started as well, if required to run on the same system.

By following these steps, you will successfully install the Dualz MOSAIC Editor and configure it to work with your
mosaic network.
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UPGRADE PROCEDURE

When the MOSAIC software is upgraded, and you want to keep existing configuration, we recommend to save the
editor XML file(s) to a save location. Use “File -> Save as” to store a backup to a save location. Or just copy the use
xml file to a save location.

During a software upgrade you need to uninstall previous version first.

NOTE: an update from a version lower than 3.14, or a higher version requires a repositioning of the screens.
The newer version have the HDMI/DP selection on the output monitor.

USER INTERFACE

The user interface of the Multiviewer (network) Editor is shown below.

5 -c - 8 x
Inputs  Servicemap  Screens  View  Help

It contains 5 parts, being:

e Application menu
e Screens overview

e  Blocks overview

e  Service maps

e  Mosaic layout view
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FILE

The file menu is shown below.

File | Service network

Mew 3
Load
Save

Save as .

Preferences

Exit

New: Create a new setup based on a template (empty, 2x2 or advanced demo).

Load: Load an existing configuration from disk.

Save: Saves the current configuration to disk.

Save as: Saves the current configuration to a specific file on disk.
Preferences: Preferences menu.

Exit: Exits the editor application

PREFERENCES

The Preferences form is shown below.
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De4nterlace mode:
Option:
Full screen interval: gec (0 : until double click)
aseport RTF gateway: (0': No RTP to UDF gateway)

SMART inteface directory:

MNDI audio boost: MDI latency decrease:

De-interlace mode: Specifies the de-interlace mode for video displays
Option: You can add specific options here. This is to be used by support engineers.

Full screen interval: When a tile is shown in full screen (via double click or popup menu), this value determines the
interval before going back to mosaic mode. If O, the full screen mode stays active until double click.

Base port RTP gateway: In case a number larger than zero is given, the RTP streams are transferred to UDP before
fed to the MOSAIC. The UDP ports are increased per RTP stream.

SMART interface directory: In case of SMART combination, this is the location where SMART exports the service
data.

NDI audio boost: Amplifies NDI audio channels.
NDI latency decrease: Decreases NDI latency, be careful using this value!

UMD Colors: Configuration of foreground and background color of the UMD (Under Monitor Display), service
names under the displays.

INPUTS

The inputs menu is shown below.

File | Inputs | Service map  Screens View  Help

Define inputs
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Inputs: Edit form to enter input services.

The following form is shown.

ZZ P inputs X
D Name Type Description
0
D d
Add Edit Remove Remaove all
Save Cancel

You can Add, Edit, Remove and Remove all services.

The edit form is shown below:

2 Service settings X

Name UDP 235.5.5.5:5556 W Video only

g5
(W11 il -/ /@235 5.5 55506

Example: http server nl/stream.m3ud

Set profile Max bandwidth i)

Sub stream

Example: htt our_server nl/stream.mJud

B Set profile
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Input protocol: Defines the type of stream, being one of the following:

e Generic URL: Any url can be given starting with for instance udp://, rtsp://, http://, rtsp://, rtmp:// and
more.

e UDP, RTP, HLS, DASH, RTSP, RTMP, FILE, SRT, ZIXI (each protocol with specific settings)

e  HDMI/SDI: Input via Magewell card HDMI or SDI, also usb camera supported.

e NDI*: NDl input stream
*“NDI® is a registered trademark of NewTek, Inc.”

e Clock

Video only: If a source video only contains video (no audio), select “Video only” in order not to show VU meters,
and not to check on audio loss.

GERNERIC URL

The input form for “Generic URL” is shown below:

22 Service settings =

Mame UDP 235.55.5:5556 W Video only
Input protocol  fEE NN -

Settings
(N1 idp//@235.5.5.5:5556

Sub stream

URL: URL for stream source. Enter your stream URL (http, udp, rtsp, rtp, DASH, HLS, ...).
Examples:

e udp://@235.5.5.5:5555

e http://dualz.video:1935/vod/mp4:sample.mp4/playlist. m3u8
e rtsp://dualz.video:1930/vod/sample.mp4

o file:///C:/Teststreams/test.ts

Sub stream: Enable sub stream, for retrieving lower quality stream in case of small tiles (smaller than 720 width).
This setting lowers network traffic and improves multiviewer performance (a lot).

UDP / RTP
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Z Service settings X

Name UDP 23555 5:5556 B Video only

Settings

IP address 235.5.5.5 T 5556 |

Interface MIC Default v Use proxy Il

mwets  PogiD B m ~cioPD B

IP Address: IP address for UDP/RTP input.
Port: Port for UDP/RTP input

Interface NIC: In case of UDP or RTP multicast input, this field defines the local network interface card, where to
find the input feed. The multicast join will be done over this NIC.

Use proxy: Used by service engineers only, in some cases (RTP based) an internal proxy is needed to get the
stream properly from the network switch. Recommended only to use this setting in case of problems.

MPTS: Specifies whether the source is a Multi Program Transport stream, if so you can add the service id of the
program to be decoded.

Audio PID: If the source contains multiple audio PIDs you can specify the audio component here.

HLS
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ZZ Service settings et

W Video only

Settings
(01210 ittps ./ your_server/stream m3ud

Example: hitp:, r_server nl/stream.m3ud

Set profile | JETR— w

Sub stream

hitps://your_server/stream m3ud

Example: hitp ur_servernl/stream.m3ud

Set profile Max bandwidth ST

URL: HLS input URL main stream.

Set profile: Select the HLS profile, if available: Lowest, Manual, Auto, Highest.
In case “Manual” is selected, you can enter the max bandwidth to be used.

Sub stream: Enable sub stream, for retrieving lower quality stream in case of small tiles, i.e. smaller than 720
width. This setting lowers network traffic and improves multiviewer performance a lot.

HDMI/SDI

The input form for “HDMI/SDI” is shown below:

ZZ Service settings hod

UELER HDMI stream 1| B Video only
Protocal
Input protocol Wil il

Video Audio

Useinputid W
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HDMI / SDI: Select this item in order to read an HDMI or SDI input. You can either select the video and audio
components, or use the index of the video/audio sources.

NOTE: Selecting video/audio from the presented list only works if the editor runs on the same system as the
multiviewer screen.

Video: Select a detected video interface.
Audio: Select a detected audio interface.

Use input id: In case the editor runs remote and the detected interfaces are not known (yet), you can select the
index of the selected interface on the screen where it will be running.

NDI

The input form for “NDI” is shown below:

ZE Service settings X

Py

NDI stream: NDI source, shall be in the format: ndi://<pc_name>/<source>

NOTE: For NDI support you'll need the NDI runtime installed on the system where the screen application is
running. Download from https://ndi.video or contact Dualz or your local distributor for help.

NOTE: Firewall may restrict NDI tiles.

CLOCK

The input form for “Clock” is shown below:

#Z Service settings X

Protocol

Settings
M Digtal  Offset

-

10
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Clock: Add an analogue or digital world clock to the multiviewer layout. You can specify the time zone by specifying
an offset.

Clock label: Can be set to “Name”, “Date” or “No label”.

SERVICE MAP

The Service map menu is shown below.

Service map | Screens  View

Auta fill

Unmap all

Auto fill: All services in the list are automatically mapped to a display

Unmap all: Unmaps all services in current service map.

SCREENS

The Screens menu is shown below.

Screens | View  Help

Screens network

Update all screens
Force update

Close all screens

Screens network: Define all you screens in your network

Update all screens: This function updates all screens, in case of any changes in the configuration. This function is
the same as the “Update all multiviewers” button in the Multiviewer Editor screen.

Force update: Even when no changes are made in the configuration, all multiviewers perform an update (restart of
the screens).

Close all screens: Remotely closes all connected screens.

SCREENS NETWORK

When “Screens; network” is selected the following Ul is shown.

11
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Screens n

Screen (M ] Properties

Screen 1D

Penalty box [l
mmunication

Direct, IP =

COutput stream

Encode MV [l 4000 & TR

Add: Add a screen.
Remove: Remove a screen

Edit a screen: Configure the screen settings of the selected screen.

ADD/EDIT SCREEN

When Add or Edit screen is selected the following Ul is shown.

Screen settings n

NTar ot 0 DISPLAYT,  X=0 =0 (Primary) ~ B Penalty box

Frame rate v use IPaddress [iepiVAl ~ Start server
Resolution (WxH)

P B Use email

Email settings

- Server <SMtp servers
127.0.0.1 o

From <your mail>

To <to mail>
127.00.1 Port  Eald User p—

Password 000K

m This URL iz used as hyperink in the email body

12
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PROPERTIES

Screen ID: Unique identification of a screen.
Monitor output: Defines the Windows HDMI/DP output.

Penalty Box: Specifies whether the selected screen is the Penalty Box.
Only one screen can serve as penalty box.

Nightly Reset: Specifies whether the screen shall be reset on daily base. ‘Reset hour’ defines the time of the daily
reset,
Use proxy/server licensing: Server location for licensing through proxy/server.

OUTPUT STREAM

Enable MV: Enabled the Multiview output stream

Encoding bitrate: Target bitrate for encoding

Frame rate: Frame rate of the output stream

Resolution: Resolution of the encoded output video

Unicast: IP address and port of the outgoing unicast stream

SRT (Listener mode): NIC and Port of the SRT stream in listener mode

Multicast: NIC, IP, Port and TTL value of the outgoing multicast stream. IP must be in multicast range

In order to test the stream, you can define a channel, for example on input udp://@235.5.5.5:2080, and see if the stream is shown in the
MOSAIC itself.

NOTE: The output stream can be used to view on the same or a remote screen. It can be used to feed a
streaming engine (like wowza, NGINX) as well. The MV output stream is a variable bitrate stream (VBR), and
shall not comply to DVB standards, or TR290 specifications.

WEB SERVER

The alarms “Audio/Video loss” can be send to a web server. This can be an internal server (started by the screen
application), or an external server, started via desktop icon, or even externally running on another system.

Use: Indicates whether alarms must be send to a web server.
IP address: IP address of web server, can be localhost (127.0.0.1).
Port: Port of web server.

Start server: Indicates whether this screen must start the web server.
NOTE: Be careful in configuration where the web server is to be started. Especially when multiple screens are
involved.

13
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EMAIL SETTINGS

NOTE : These settings are only applicable if “Start server” is enabled.
Use email: Indicates whether the server must sent emails or not.
Server: SMPT Server.

From: From email address

To: To email address.

User: User name

Password: email password
Port: SMPT port
Interval: The minimum interval where mails are sent, in order to prevent many mails.

URL webserver (external): When an email is sent in case of an alarm, the message body includes the URL of the
web server. This URL must externally be reachable when mail is sent externally.

COMMUNICATION

Defines how to communicate with the screens, this can be done via

e Direct screen : network socket connection, be sure that the screen port matches the one configured in
Screen Manager (Windows programs — Dualz Solutions — Screen manager).

e  Configuration file: In case of SMART-MV, this screens supports a file based interface

e Config node: In case a config node is active, the screens setup can be pushed to the config node.

VIEW

The View menu is shown below.

View | Help

Refresh LI

Refresh Ul: Refresh of the Multiviewer Editor Ul.

HELP

The Help menu is shown below.

14
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Help

Manuals 3

Legging b

Visit dualz website
Contact Dualz
About

Manuals: Visit our online manuals. Note that these will be updated along with the new MOSAIC versions.
Logging: To be used for problem analysis purpose

Visit Dualz website: Link to Dualz website: https://dualz.com

Contact Dualz: Contact Dualz for support or information.

About: Application information.

BLOCKS OVERVIEW

LIST OF BLOCKS

The list of blocks panel is shown below.

Blocks can be added here, and a selected block can be deleted.

A block is an area within a screen that contains pages that are shown iteratively (round robin mode). Each display

in a page/block is of equal size, and positions are fixed.

BLOCK CONFIGURATION

The block configuration is shown below.

15
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Selected block

Posion  x v [
Size « BN+ E2N
# Displays hor vert

Display Width Bk Auta

Height
H Pages Interval (zec) m
VU meters LMD

B Audio onby Alam notification

ID: Block ID

Position x,y: Defines the location of the upper left corner of this block.

Size w, h: Defines the size (width and height) of this block.

# Displays hor./vert: Number of displays horizontally and vertically

Display Width/Height: The width and height of each display in this block

# Pages: Number of pages in round robin mode.

Round robin Interval: The interval (in sec) in which round robin pages are shown.

VU meters: Indicates whether VU meters are shown or not.

Audio only: Video is hidden, radio service.

UMD: Defines whether the Under Monitor Display (with service name) is shown or not.

Alarm notification: Visual alarm notification in case of audio or video loss.

ADVANCED BLOCK SETTINGS

The form “Advanced block settings” shows the advanced parameters on block level.

16
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Z Advanced block settings by

GPU decoding

<,

RTSP TCP

Low latency

(< |

Maintain aspect ratio

A

Reset on video loss

<

Reset on audio loss
Reset on arifacts

Reconnect on stream end

Multithreaded decoding

VU meters

GPU decoding: If the video card supports it, GPU based decoding can be used. The following options are available:

e None: No HW acceleration is used. Decoding is done in CPU.
e DXVA2: DXVA2 GPQ decoding method
e  Any: Automatic selection of any supported HW accel method.

RTSP TCP: In case of RTSP input, this parameter defines the communication protocol. TCP communication is more
reliable.

Low latency: Defines whether a display is shown in low latency mode, or needs buffering.
Note: Recommended to use Low latency only in LAN environment. In case of internet connection disable low latency
setting.

Maintain aspect ratio: Defines whether the aspect ratio must be maintained, or the display is stretched to the
display dimensions.

Reset on video loss: If audio or video loss is detected, reset the tile.
Reset on audio loss: If audio or audio loss is detected, reset the tile.

Reset on artifacts: If the decoder encounters issues in the incoming stream, the tile will be reset.

17
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Reconnect on stream end: If possible, when the stream stops, reconnect or restart the stream. Applicable for file
or VOD based HLS stream inputs for example.

Multithreading decoding: Use single or multithreading decoding algorithm.
Note: Recommended to uncheck multithreaded decoding. Only in case of decoding or rendering issues, you can try
this method.

Solid VU: Shows VU meter in solid color.

Figure 1: Solid versus non soli VU meters

Show scale: Shows VU meter scales.

SERVICE MAPS

SERVICE MAPS

The service maps define multiple multiviewer layout sets. When a map is selected, the complete multiviewer setup
can be set to another layout. You can use Drag & Drop to map the services to the display tiles!

18
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Service maps

Service map 0

Mapping
IO Mame Screen  Block  Page  Tile

Bunny 1
Bunny 2

—_
—_

d L3 P =

=} LN
o

B G P P P R RIER— — —

1
1
1
1
1

Audio? 1
Audiod 1
Audiod 1
AudioS 1
1
1
1

(LSRR EY . -

(=g

Audiob
Local system time

-
.
.
.
:
-
1
.
.
.
.
.

R —

Remote location
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LIST OF SERVICES

Within a service map, the services are mapped to display tiles. The list of services panel is shown below.

0 MName ScreenlD  Block Page  Display ID

Dema 1

—_

Dema 2

]
o
—

(3, I - TR U R

Demo 3
Demo 4

Demo 1: ...

Demo 4: ..
10 Demo 4: ..

1
1
1
1
1
1
1
1

P Pud Pud Pl P B — —

f=r]

ID: Each service is provided with a unique ID.
Name: Name of the service

Screen: ID of the screen this service is mapped to
Block: ID of the block this service is mapped to
Page: ID of the page this service is mapped to
Display: ID of the display this service is mapped to

A right click on a service, shows a popup menu.

Add to penalty box / remove from penalty box: in order to add or remove this service to the penalty box. If a
service is added to the penalty box it is shown in red.

Audio on/off: Enables or disables the audio over speaker. If a service has audio enabled, it is shown in green. On
the multiviewer tile (in multiviewer screen) an audio icon shall be visible.

20



Figure 2: Audio icon

Map: Edit form to fill in mapping settings manually.

2 Demo 4 >

Screen (D
Block 1D
Page ID

Display D

B To penalty box

The settings in the service list (see above) can be entered here.

MOSAIC LAYOUT VIEW

The mosaic layout view is shown below. The layout belongs to the selected screen.

Dualz
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The services mappings are shown in this layout view.

When the ‘Page<ID>’ label is clicked, the round robin pages can be iterated. Use this function if you want to drag &
drop to a specific page.

MOSAIC LAYOUT VIEW STARTUP PARAMETER

If a startup (command line) parameter, which needs to be an xml file name, is added to the editor application, this
file is the document that will be worked on, and leading for the network configuration.

Multiple xml files can co-exist. This way a complete multiviewer network layout switch can be performed just by
selecting another xml file, and pushing it to the multiviewer servers.

ALARM INTERFACE

The web server listens to port 9026. Locally, you can open a browser om: http://127.0.0.1:9026.
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1: Dema 1 (trial) 2: Dama 2 (trial) 3: Derma 3 (brial) 4: Demo 4 (trial) 5: Dema 1: pid 272 (erial)

Status: Dhay (D) ] Suatus: Ohay 10)
Thene: H121-08-24 F:i2-08 218 Tieme: 210} AlE Tiene: 2020-00-24 J:k:08.417

Stal

6: Demo 1: pid 288 (trial) 7: Demo 2: pid 272 (urial)  8: Demo I: pid 288 (trial)  9: Demo 4: pid 272 (trial)  10: Demo 4: pid 288 (trial)

Seatuss duedls loss
Timwe: 2021-00-24 111

The web browser will show the statuses of your streams. You can access the web server remotely. Note that the
port must be forwarded on you router, if accessed from outside your LAN. Also be aware of firewall issues.
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